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Version Highlights - New Features

1. Default times

« System time Parameter valuesin the editor use thistime.

* Release time fade out time for released parameter levels and playback loads.

* Library time Applied library values fadein time.

* Sneak time The fadein or out time for levels operating under the sneak function.
2. Delta

Update cues by pasting the values stored in the delta cue.
3. Effects

* Pre-built effects Color Mix and Rainbow have been added to the pre-built effects.

* Fixture grouping Spread the effect over groups of fixtures.

- Base value The base value is now displayed with the active parameter.

¢ Include Base The base value stored in an effect library overrides the value in the editor.

4. Fixture mode

specifying the fixture type.

When fixtures are patched so there are not overlapping fixture numbers, you can select fixtures without

5. Help
For on-line help, tap Help and choose Content, Index, or Search.

6. Home cue
Store fixture specific home values that override home values specified in the device definition.

7. Layout files

saved in the *.cfg (layout) files.

« Grid properties Customized grid properties, such as font and color, are now saved in the
*cfg (layout) files.

« Format and live mode now Saved in the *.cfg (layout) files.

» Lock windows Thelock icon has been added to the basic displays. The lock statusis now

8. Libraries and groups
Generate color libraries and groups automatically.

9. Libraries
Improved functionality for bank filters

10. Loading show data
Selectively load the objects, sets, devices, or patch, using the Import item under the File menu.

11. Master/Slave
Improved master and slave switch over

12. Pan and tilt orientation
Access the pan/tilt patch from the Editor toolbar in parameter values mode.
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13. Parameter Grouping

Parameter grouping can be toggled on or off from the editor toolbar.

14. Playback

* Global go and freeze
commands

* Playback control behavior
* Playback wing display

* Rate wheels

A rate mode for the Editor toolbar. Pause or restore all active chases and
effects.

On/off has been implemented
Improved playback wing display
3 wheelsfro global rate control

15. Release
* Dedicated release time

* Release fixtures or
parameters

¢ Dimmer levels set to zr

Set arelease time in the System Settings dialog box.

Release fixtures or parameters from arange of cues.

New behavior in Compulite and tracking modes.

16. REM DIM

I solate fixtures for identification and editing.

17. Selecting objects
* Active

¢ Dim

Select active fixtures without specifying the output source

Set Dim as the default numeric selection.

18. Store options
¢ All Params If Active
* All Params for Selected

« Default in Editor toolbar

Stores dl parametersin the cueif thereis no dimmer level.
Stores al parameters for the selected fixtures.

The store options in the editor toolbar always revert to the default as
defined in the System Settings diaog box.

19. Views and displays
New and improved displays for:
» DMX ports
* Editor Toolbar
* Fixtures in TOPO

» Last selection

* LookAhead exam

¢ Show name and info

¢ Tracksheet

DMX port display now shows: port number/DMX channel (1 - 512)
Buttonsin the default (idle mode) toolbar have been changed.
Fixturesin the topo map now show their DM X addresses also.

The fixture names that part of the last selection are displayed in yellow in
the live spot and channel displays.

The show’s hame is displayed in the general window title bar. Show file
information is displayed in the workspace's show node.

View how a channel or spot tracks through the cues.
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Summary of Changes
FEATURE DESCRIPTION
Displays An exclamation point sometimes appeared in te status bar for no reason. This does not
happen anymore.
The master playback cue sheet display did not refresh correctly. Now it does.
Fade times Pressing GOTO 0 did not work. Now it does.
Pressing GOTO 1.5 generated an error message. This does nhot happen anymore.
Ignite spots Sending an ignition (lamp on) command, when 2 types of devices were selected,

Loops and Links

Master/Slave

Matrix
New Shows
Park

Patch

Selecting fixtures

Update

VL1000 device

generated an error message. This does not happen anymore.

When loops and links were combined the playback did not function correctly. This
has now been corrected.

Updating cues on the master console caused some temporary cues to disappear on the
slave console. This does not happen anymore. Thank you to the crew at Lisys and
House of Tradition, Hungary.

Incorrect data was displayed when switching views between 2 matrixes. This does not
happen anymore. Thank you to Gerhard Feiner, Germany.

The console data was not cleared properly when opening a new show. Now the warm
dataiscleared correctly.

For channels, the parked icon was displayed only in the fixture name field and did not
appear in the fixture number field. Now it appears in the fixture number field also.

Proportional patch settings were cleared if more than one dimmer was patched to a
logical channel. This does not happen anymore.

The proportional patch settings and pan/tilt patched were not saved after shutdown
even if the show was saved before exiting. Now this information is saved.

An lllegal Set message was generated when selecting achannel on the touch screen (in
interactive mode) and attempting to select another channel by pressing + and selecting
anumber on the keypad. This does not happen anymore. Thank you to Gerhard
Feiner.

When updating channels that were output from the master playback and were also
loaded to afader whose fader was at zero, the MASTER PLAYBACK ONLY buttonin
the Update dialog box was not available. Now it is. Thank you Andy Stone at Stag-
etec, Great Britain.

Tracking only! When updating values whose source were libraries, the Update Library
option did not appear in the Update dialog box. Now the libraries appear in the dialog
box.

The home value, as defined in the Device Builder, for VL1000 rotating gobo rotation
was incorrect. The home step is now defined as Stop, so the gobo wheel does not
rotate when idle. Thank you, Gerhard Feiner.
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| Limitations

Limitations
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10.

11
12.
13.
14.
15.

Device Builder. Due to restructuring the manufacturer’s 1D, any operator defined devices may not appear
under the correct manufacturer. To fix: go to the Device Builder and save your device again under the correct
manufacturer.

The key function is not displayed in the key function filed for the A/B crossfader in the A/B view.
Itisimpossible to playback atimed or manual cue out of sequence when loading the cue using the select key.
To reset channelsto zr, it is necessary to press RESET twice.

Snaps, from shows saved on older software versions, do not remember the level of the faders stored in the
snap.

Not all keys stored in the macro are displayed when examining the macro.

The contrast and brightness controls for the touch screens are not working yet.

Itisimpossible to set the proportional patch level from the editor toolbar.

there is no way to disable the general master’s blackout key (B.O.). Thiswill be implemented in the future.

Green Vector only! After power up the general master level is not displayed. Workaround: move it a bit and
it will be displayed.

The sequence EXAM, SELECT does not work yet.

The screen refresh command does not work in the TOPO view.

In the Topo view, dimmer levels for a device with a 16 bit dimmer does not display in percentage.
Cannot scroll down in the cue sheet.

Auto save for shows that are 8 megabytes and up may take longer than usual.
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Operating New Features

1.0 Default times
The various default fade times are set in the System Settings dialog box, Timing tab

System time Speed at which levelsfadein or out in the editor.

Release time Speed at which released parameters fade out when released from the editor or
from a playback device.

Library time Speed at which library levelsfade in or out in the editor

Sneak time Speed at which levels fade in when using the sneak feature.

To change default times

1 Open the Tools menu.
2 Tap Settings.
The System Settings dialog box opens.
3 Gotothe Timing tab.
4 Enter time values in the default time fields.

5 Tap OK to save and exit.

2.0 Delta

A delta contains absolute and relative modifications of spot parameter levels, channel intensity, and
scroller frames. Deltais used to edit cues by pasting the levelsin the delta to the target cue. The
levels stored in the delta are grabbed from the editor. The delta feature uses the copy and paste func-
tionality, therefore anything copied to the clipboard overwrites the delta. You can store anew delta
at any point in programming segquences. Vector supports one delta.

2.1 Delta options
There are three options when pasting the delta:

m Relative - the toolbar always defaults to this option.

m Absolute
= Add new

Figure 1: Editor toolbar in delta mode
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2.1.1 Relative

DELTA (as copied when
editing a cue)

TARGET CUE

TARGET CUE AFTER
PASTING DELTA

Channel 1 Absolute: 90
Relative: +30

Chaanedl 1@ 35

Channdl 1@ 65

Channel 2 Absolute: 90
Relative: +60

Channel 2@ 50

Channel 2@ FL

Channdl 3 Absolute: 80
Relative: +30

Chanel 3@ 30

Channel 3@ 60

Channdl 4 Absolute: 30
Relative: -40

Channel 4@ 80

Channedl 4 @ 40

2.1.2 Absolute

DELTA (as copied when
editing a cue)

TARGET CUE

TARGET CUE AFTER
PASTING DELTA

Channel 1 Absolute: 90
Relative: +30

Channdd 1@ 60

Channdl 1 0

Channel 2 Absolute: 90
Relative: +60

Chand 2@ zr

Channdl 2 0

Channdl 3 Absolute: 80
Relative: +30

Chanedd 3@ 30

Channdl 3 80

Channdl 4 Absolute: 30
Relative: -40

Chandd 4@ 80

Channdl 3 30

2.1.3 Add New

DELTA (as copied when
editing a cue)

TARGET CUE

TARGET CUE AFTER
PASTING DELTA

Channel 1 Absolute; 90
Relative: +30

Channel 1@ 60

Channedl 1@ 60

Channel 2 Absolute; 90
Relative: +60

Channel 2@ notincue

Channel 2@ 90

Channel 3 Absolute; 80
Relative: +30

Channel 3@ 30

Channel 3@ 30

Channel 4 Absolute; 30
Relative: -40

Channel 4@ 80

Channel 4@ 80
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To copy the delta from the editor

Select fixtures and adjust levels.
Press @.
Press COPY.

The absolute and relative values are copied from the editor to the clipboard and are ready
for pasting.

OR

Select fixtures and adjust levels.
Press UPDATE.

The Update dialog box opens.
Tap COPY NEW DELTA.

The absolute and relative values are copied from the editor to the clipboard and are ready
for pasting.

To paste delta values

Example: Update cues 5 through 9 by pasting the levelsin the delta.

1
2
3

Press CUE, 5, =, 9 to select cues 5 through 9.
Press @.
Press PASTE.

The cues are updated with the new values.

Note: Using this sequence assumes pasting the relative values in the delta.

OR

1
2
3
4

3.0 Effects

Select cues.

Tap DELTA.

Optional: tap RELATIVE, ABSOLUTE, or ADD NEW.
Tap PASTE on the deltatool bar.

The cues are updated with the new values.

3.1 Basevalues
The base value is now displayed next to the active parameter.

3.2 Effect dialog box position

The default position for the effect editor dialog box is aligned left, so the Offset, Size, Rate, and
Duty attributes appear above their control wheels.

Note: Vector remembers the dialog box’s last position, thereforeif it was moved it will

not be aligned with the wheels next time it opens.
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3.3 Fan param

The Fan Parameters option fans the effect over parameters. This alows control over the parameters
in asingle spot.

To fan parameters

Example: Apply afan effect to cyan, magenta, and yellow in spot 1.

1
2
3

Select spot 1.

Select cyan, magenta, and yellow.

Press EFFECT.

The Effect Editor dialog box opens.

Select a primitive from the Pre-built, Basic, or Advanced tabs.

Go to the Advanced tab.

Tap FAN PARAM.

The Offset, Size, and Rate attributes can now be set for fanning parameters.
Adjust the Offset, Size, and Rate attributes as required.

3.4 Fixture grouping

Fixture grouping with offset determines how the offset is spread among the devices.

Example: An intensity step effect is running on spots 1 through 10. All 10 spots turn on and off at
the same time. Set the fixture grouping to 2 and tap WAVE. Now the odd spots are on when the even
spots are off and vice versa.

3.5

Include Base

Base values in effect libraries override the value in the editor.

3.6 Pre-built effects
Some effects have been added to the pre-built tab.
m Color Mix (Color Mix applies CMY, with an offset, from FL to zr.)

4.0

m Rainbow

m Dimmer Step

m Dimmer Fade

m [risIn Move

m Focus

Fixture mode
Patching fixture sets so there are no overlapping fixture numbers allows you to select fixtures
without specifying the fixture type.

An example of fixtures patched with no overlap is:
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FIXTURE SET FIXTURE NUMBERS

Channel 1to 100
Spot 201 to 300
Matrix 401 to 512.

When fixtures are patched with no overlapping fixture numbers, Fixture appears in the command
line as the default numeric selection. CHANNEL, SPOT, and SET are, of course still active for
examining fixtures, etc.

To select fixtures in fixture mode

Just choose the fixture's number on the keypad.

5.0 Help
To open help
1 Open the Help menu.
2 Tap Context.
The on-line help file opens. Browse according to topic, index entries, or search.

Note: There are two books available in the help file: Action syntax and Enter
(Broadway style) syntax. Choose the help for the syntax that you are using.

6.0 Home Cue

Occasionally a parameter’s home level, as set in the device definition, is not compatible with some
fixtures because of, for example, their hanging positions. You can store a fixture specific home cue,
which overrides home levels set in the device definition. Values for fixtures not included in the
home cue go the values set in the device definition.

To program the home cue
1 Select the fixtures.
2 Select the parameters and set the parameter levels.
Press STORE.

3

4 PressCUE.
5 PressHOME.
6

PressENTER.

To delete the home cue
1 PressDELETE.
2 PressCUE.
3 PressHOME.
4 Tap DELETE again or press ENTER.
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7.0 Layouts

7.1 Grid properties

Grid propertiesthat you have customized in the Grid Properties dialog box > Grid tab are now saved
with your layouts.

You can customize the ook for: specific display panes:

COLUMNS ROWS GRID LINES
» Font * Font * Row line weight
» Font (foreground) color » Font (foreground) color e Column line weight

« Background (field) color e Linecolor

To customize grid properties
Example: Customize the grid look for the master playback pane.
1 Point at one of the headings in the master playback pane and right click.
2 Choose Properties from the fly out menu.

The Grid Properties dialog box opens.

Go to the Grid tab.

Tap Customize to enable the fields.

Set the fields.

o 01~ W

Tap OK to save and exit.
These settings will be saved with your layout.

To return to default grid properties
1 Point a one of the headings in the master playback pane and right click.
2 Choose Properties from the fly out menu.
The Grid Properties dialog box opens.
3 Goto the Grid tab.
4 Tap Customize to disable.
All fields return to their factory default settings.
5 Tap OK to save and exit.

7.2 Formats and fixtures displayed

All display customization done through the Format menu or the Live Mode menu are now saved
with layouts.

8.0 Libraries and groups - automatic generation
Through the Generate Libraries and Groups dialog box, Vector automatically generates:

m Color libraries

Do
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m Intensity libraries
m Image libraries

m Groups

You can choose to generate some or al of these objects for some or all of the devices used in the
show.

& Generate Groups and Libs

= |V| Generate All ~ Option:
....... 7 Start From: I‘I &l
....... 7 Intensi
] k4 Align: I'ID
....... V| Image
R 7 Groups
EE Generate For Devices I Primary Device |1113.Mac B0 md =l
....... /] 2208.vL2402
] Separate Libraries: |
....... ¥/| 1.Channel
....... | 1113 MacB00 m: | L
....... | 502.cheScrl 11F
I Leave Ovenarite Update |
| |

Figure 2: Generate libraries and groups dialog box

You can number the libraries and groups to your convenience in the dialog box’s numbering area.
The numbering option fields are:

Start From Store the first generated library or group to the number in this field and sequen-
tialy increment the libraries or groups.

Align Choose an offset. Generally, it is convenient to chose an offset that corresponds
to your display set up.

Example: Assume that you have sized the soft keys pane to show 5 soft keys per
row. You choose to generate 5 groups for each fixture type. If the start number is
1 and the offset is 10, the generated groups will appear in every other row.

If there are existing libraries and groups you can choose to:
m Leavethemasis
m Overwrite them

m Update them

To open the Generate Groups and Libs dialog box
Open the Tools menu and tap Generate Groups and Libs.
OR
1 PressSET.
2 Tapthe GENERATE GROUPS AND LIBRARIES button on the Editor toolbar.
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8.1 Generating libraries

D

Color and image libraries can be generated for one device or for multiple devices. When generating
these libraries for multiple devices, you must select a primary device. Vector generates the libraries
for multiple devices according to the primary device. Example: You want to generate color libraries
that will be common to three devices. The primary device has a color wheel and the other 2 devices
lack a color wheel, but have CMY color parameters. The libraries are generated according to the
primary device's color wheel. For the other devices, Vector setstheir CMY levels to match the

primary device's color wheel.

You can aso chose to generate separate libraries for each device.

IMPORTANT! To generate libraries the check box next to the library type must be
checked and the library type must be selected. When selected the library type (or group)

appearson alight field.

To generate common color or image libraries for multiple devices

1
2

(&)

6
7
8
9

Open the Tool menu.

Choose (tap) Generate Groups and Libs.

The Generate Groups and Libs dialog box opens.

Expand Generate All.

Make sure Color or Image are checked.

Tap Color or Image to select.

Theitem appearson alight field.

Set the start number and the interval.

Select the primary device from the drop down dialog menu.

Make sure the devices are checked under the Generate for Devices list.

Select the behavior (Leave, Overwrite. or Update).

10 Tap APPLY or OK.

The libraries are generated according to the primary device.

To generate separate color or image libraries

1
2

Open the Tool menu.

Choose (tap) Generate Groups and Libs

The Generate Groups and Libs dialog box opens.

Expand Generate All.

Make sure Color or Image are checked.

Tap Color or Image to select.

Theitem appears on alight field.

Make sure the devices are checked under the Generate for Devices list.

Set the start number and the interval.
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Tap SEPARATE LIBRARIES.

Select the behavior (Leave, Overwrite. or Update).

10 Tap APPLY or OK.

Libraries are generated for each device.

To generate intensity libraries

© 00 N o o b~ w

Open the Tool menu.

Choose (tap) Generate Groups and Libs.

The dialog box opens.

Expand Generate All.

Make sure Intensity is checked.

Make sure the devices are checked under the Generate for Devices list.
Set the start number and the interval.

Set the level incrementsin the% Step field.

Select the behavior (Leave, Overwrite. or Update).

Tap APPLY.

8.2 Generating groups

The automatic fixture group options for spots per device, channels, and scrollers are:

m All

m Even
= Odd

m Every third - counting from the first fixture of a device type.

m Every fourth - counting from the first fixture of a device type.

To generate groups

1
2

(&)

© 00 N O

Open the Tool menu.

Choose (tap) Generate Groups and Libs.
The dialog box opens.

Expand Generate All.

Make sure Groups is checked.

Expand Generate for Devices and make sure the devices you want organized into groups
are checked.

Set the start number and the interval.

Select the type of group (Even, Odd, All, 3rd, 4th).
Select the behavior (Leave, Overwrite. or Update).
Tap APPLY.
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9.0 Libraries
The functionality of the bank filters has been improved.

D1

In some cases, you might want to store parametersin libraries that do not normally accept such
parameters. For instance, you might want to store pan and tilt in a color library, which normally
allows only parameters belonging to the color parameter type. When BANK FILTER is off, any
parameter can be stored in alibrary.

The default isBANK FILTER on and the button has an orange field.

To store an unfiltered library

Example: Store all parameters active in the editor in acolor library.

~N o o~ W N P

Select the fixtures.

Set adimmer level.
Adjust the pan and tilt.
Set color levels.
PressLIB.

Press COLOR.

Tap BANK FILTERS.

The button now has a blue background and library filtering according to parameter typeis
cancelled.

Storeto acolor library.

The color library contains dimmer, pan, and tilt, aswell asthe color parameters.

To store some active parameters in a library

Example: Pan, tilt, dimmer, and color parameters are active in the editor. You want to store
pan, tilt, and color settingsin acolor library, but not the dimmer.

1

g b~ W N

Select the fixtures.

Set adimmer level.

Adjust the pan and tilt.

Set color levels.

Press POSITION.

The position wheel bank is now available.
Press the parameter keysto select pan and tilt.
Pan and tilt are now selected (they appear in red) in the editor.
PressLIB.

Press COLOR.

Tap BANK FILTERS.

The button now has a blue background and library filtering according to parameter typeis
cancelled.
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10 Store to acolor library.

The color library contains pan, tilt, and the color parameters.

10.0 Loading specific objects and patch information

You can load selected objects or patch information from showsto Vector. Thisis useful, for
example, if you want to reuse the patch or libraries from a previous show.

The objects you can load are:
m QLists- all or specific QLists
m Libraries- all or specific libraries
m Groups
m Snaps
m Macros
The patch information that can be loaded includes:
m Devices
m Sets
m DMX address patch

Numbering imported objects is customizable. The Numbering Options group in the Import dialog
box allows you to:

Example: Your current show has QLists numbered from 1to 5. You are importing QLists 4
through 6 from a previous show.

Append Start numbering imported objects from the next available number. As per the
example: The imported QList 4 becomes QList 6, imported QList 5 becomes
QList 7, and imposed QList 6 becomes QList 8.

Start From Specify the start number for the imported objects. As per the example:
Starting from 10, imported QList 4 becomes QList 10, imported QList 5
becomes QList 11, and imported QList 6 becomes QList 12.

Keep Original | The original object numbers are preserved. If there are objects in the current
show with the same number, the imported object will not be loaded. As per the
example: Only QList 6 will be imported.

Overwrite The imported objects will overwrite the existing objects. As per the example:
imported QLists 4 and 5 overwrite the current QLists 4 and 5.

To load specific objects

1 Open the File menu.
2 Choose (tap) Import.
The Open dialog box opens.
3 Select the show and open.
4 Tap the object you want to load.
5 Select the numbering option.
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6 If required, tap SELECT or DESELECT in the Select Range group, and select the range of
cuesor libraries, etc.

7 Tap OK.

11.0 Master/Slave
There have been some improvements in the master/slave function.

1. Editor levels are transmitted to the slave console.

2. Thereisimproved runtime and windows synchronization between the master console and the
dlave console.

3. Therules governing master/slave switchover in the case of master console failure are:
a. If the master fails, the slave takes over in 100 milliseconds.

b. When the master isrestarted, it is automatically set asthe slave console. All data from the
current master console (formerly the slave console) is loaded to the new slave console.

c. If the connection to the master isrestored in less than 10 seconds after failure, it is re-estab-
lished as the master console.

12.0 Pan and tilt orientation

A PAN/TILT PATCH button has been added to the Editor toolbar in selection mode. Tapping this
button switches the Editor toolbar to pan/tilt mode.

Use the buttons in this mode to logically orient the pan and tilt directions to trackball movement.
The buttons are:

INVERT PAN - Switch the full and zero values for pan.
INVERT TILT - Switch the full and zero values for tilt.

SWAP PAN/TILT - Pan becomestilt and tilt becomes pan.

13.0 Parameter Grouping

When editing parameter levels, parameter grouping selects all parameters grouped together under
the same parameter type. If, for example, you are setting levels for pan all parameters defined as
part of the position parameter type are selected in the editor. Therefore, al parameters belonging to
the parameter type will be stored in the new library or cue regardless if they have been assigned
values or not.

By disabling parameter grouping, you can isolate a parameter from the other parameters belonging
to the same parameter type. Thisalowsyou to filter libraries by storing only the selected param-
eter(s) inthe library. Example: The color parameter type includes cyan, magenta, yellow, color
wheel 1, and color wheel 2. To store alibrary that includes only color wheel 1, you set parameter
grouping to off.

The parameter grouping default (enabled or disabled) is set in the System Settings dialog box.
Parameter grouping can be toggled on or off from the Editor toolbar.

The PARAMETER GROUPING button is available on the Editor tool bar in fixture selection mode.
PARAMETER GROUPING aways resets to the setting in the System Settings dialog box.

Dis
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To isolate parameters

Example: Parameter grouping is enabled in the System Settings dialog box. You want to store
abeam library that will contain only the irislevels.

1 Select the spots.
2 Tap PARAMETER GROUPING on the Editor toolbar.
The command line displays. Parameter Grouping Off.
3 Setthelevelsfor theiris.
Only theirisis active in the editor.
4 Storealibrary using the usual procedure.
The library contains the iris parameter only.

The parameter grouping setting defaults to on.

14.0 Playback

14.1 Global go and freeze commands for chases and effects
Put al the playback devices under global control to freeze or restore effects and chases.
Pressing RATE, switches the Editor toolbar to rate mode. The buttonsin rate mode are;
m RESET RATE -
m FREEZE ALL - toggles freezing and running all active chases and effects.
m FREEZE CHASE - toggles freezing and running all active chases.
m FREEZE EFFECT - toggles freezing and running all active effects.

14.2 Playback wing display
m The fader level and fader priority are displayed together.

m When afader is at its bottom stop, the fader level is displayed as zr.
m Theindications symbols are displayed next to the PB page and number.

14.3 Using wheels for rate control

You can control the rate for one or more than one playback device. Also, all playback devices can
be globally put under rate control.

To use global rate control (control all faders)

Press RATE; The Editor toolbar is now in rate mode and the wheels also control rates. The
wheels and the toolbar buttons affect all playback devices.

To exit global rate control

Press SHIFT + RATE. Playback device rates are reset.

To put a specific playback device under rate control

1 PressRATE (the large key next to BEAT).
2 Press SELECT for the specific playback device.
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Note: To bring additional playback devices under rate control, press their
SELECT keys.

3 Usethe CHASE RATE wheel to control the fade rate for the selected chaser or use the
toolbar buttons.

14.4 On/Off playback device definition

You can define a playback device control key as an On/Off key. On initiates a Go command; Off
releases the playback device's output. Thisis especially useful with QKeys where thereisonly one
control key available.

On/Off isatoggle. One press initiates the go command. The second press rel eases the output.

To define an On/Off key
Example: Define the control key for Qkey 10 for On/Off.
1 PressSETUP.
2 Pressthe SELECT key for a Qkey 10. The Playback Properties dialog box opens.
3 Tap the Playback Definitions tab.
4 Click on the control key.
The fly-out list shows the options.

ol

Tap On/Off.
6 Tap CLOSE to exit the dialog box and save playback device settings.

15.0 Release

15.1 Setting default release time

In the System Settings dialog box > Timing tab, you can set adefault release time. Thisrelease time
isused for parameters fading out after pressing reset and for fixtures and parameters released from
Cues.

15.2 Releasing fixtures or parameters from cues

You can release fixtures or parameters from arange of cues.

To release fixtures from a range of cues

1 PressRELEASE.
2 Select the cues.
3 Sdlect the fixture(s).
4 PressENTER.
The selected fixtures are released from the range of cues and the cues are stored.

OR
1 Tap EDIT CUE.
2 Select the cues.

Dis
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Select the fixture(s).
4 PressRELEASE.
Press ENTER.

The selected fixtures are released from the range of cues and the cues are stored.

To release parameters from arange of cues

Example: Release the cyan and magenta from cues 1 thorough 6.
Press RELEASE.

If necessary, select the QList.

Select cues 1 thorough 6: CUE 1 = 6.

Select the fixture(s).

Press COLOR.
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The color wheel bank is now available.

»

Tap CYAN and MAGENTA.
7 PresseNTER.

The selected parameters are released from the range of cues and the cues are stored.

OR

Tap EDIT CUE.

Select the cues.

Select the fixture(s).

Tap CYAN and MAGENTA.
Press RELEASE.
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PressENTER.

The selected fixtures are released from the range of cues and the cues are stored.

15.3 Releasing fixtures from cues when the dimmer level is zr

Compulite mode! When afixture’sdimmer level is set to zr, it isreleased from the editor and not
stored.

Tracking mode! When afixture’'s dimmer level is set to zr, thisis stored in the cue. If the dimmer
level remains unchanged in the next cue, no longer appears. The level zr does not track.

Example: In Cue 1, channel 1 intensity isat 75, in Cue 2, channel 1 intensity isset at zr and it saved
in the cue, in Cue 3 there is no change to channels 1's intensity therefore is no longer tracked and
does not appear in cue 3.
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16.0 Rem Dim

Another way to isolate afixture for easy identification, is by using rem dim. This feature keeps the
selected fixture or fixtures at stage values, while forcing al other fixturesto zero. REM DIM works
on all output from the editor and from playback devices.

Sincethisis an editor function, all parameters and wheels are available for fixture editing while
REM DIM is active. You can also apply alibrary to the REM DIM selection. You can store new cues
while the Rem Dim function is active. All zero intensity values (zr) are stored in the new cue.

Exiting Rem Dim releases all unchanged values to playback device control. Parameter and dimmer
values that were modified while REM DIM was active are retained in the editor.
To blackout all fixtures except the selected fixture

1 Select the fixture(s).

2 Tap REM DIM on the Editor toolbar.

Only the selected fixture's dimmer remains on. All other fixtures are entered to the editor
and forced to zr.

3 Edit and store as a cue.
Or
Tap REM DIM to exit.

To locate a fixture
1 Select astarting fixture.
2 Tap REM DIM on the Editor toolbar.

Only the selected fixture's dimmer remains on. All other fixtures are entered to the editor
and forced to zr.

3 PressNEXT or PREVIOUS to advance.
The active fixture's stage level is restored.
4 Tap REM DIM to exit and return the dimmer levelsto al fixtures.

Note: NEXT and PREVIOUS cannot be used if arange of fixtures has been selected.

17.0 Selecting objects

17.1 Selecting fixtures using ACTIVE

You can make selections without specifying a source. The fixtures selected depends on the
console’s current state. If the last selection is still active on the wheel, all fixturesin the last selec-
tion will be selected. If not al output will be selected.

To select without specifying a source

Press SHIFT + ACTIVE.

Do
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17.2 Dim as the command line default selection

When dim isthe command line default selection, Dim appears at the head of the command line. any
numeric selection is recognized by Vector as adimmer selection, without having to press dim
before choosing the number.

To set Dim as the default

Press DIM twice. Dim appears in the command line. Vector now recognizes the first number
selection as dimmer selection, making it unnecessary to press this key before the number
selection.

18.0 Store options

Default store options are set in the System Settings dialog box. The default settings can be over-
ridden on the fly while programming your show.

18.1 All Params If Active

ALL PARAMS IF ACTIVE stores all parameters output from the editor to anew cueif thedimmer is
active in the editor.

Note: If the dimmer level isset at zr, thisis aso considered as active parameter output.

To store a cue using All Params if Active

Scenario: The cuethat iscurrently output contains spots 1 through 6. The editor contains spots
1 0 through 12. You want to merge the editor output and the cue output and store as the next
cue. Usethe ALL PARAMS IF ACTIVE option.

Select the spots.

Set levels for parameters.

Press STORE.

Tap STORE OPTIONS on the Editor toolbar.
Tap ALL PARAMS IF ACTIVE.
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PressENTER.

Fixtures in the editor output and the playback output are stored in the new cue.

18.2 All Params for Selected

ALL PARAMS IF SELECTED stores all parameters for the selected fixtures, even if the parameters
are not active in the editor and even if thereis no dimmer level set.

To store active and inactive parameters in a cue

Example: Spots 1 through 6 are selected. There are active parameter levelsfor pan, tilt, cyan,
and magenta. Using ALL PARAMS IF SELECTED stores the active parameters and all other
parameters (such as color wheel, gobo wheel, iris, etc) in the cue.

1 Select the spots.
2 Setlevelsfor pan and tilt.
3 PressCOLOR and set levels for cyan and magenta.

21 &)
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Press STORE.

Press CUE and choose a cue number.

Tap STORE OPTIONS on the Editor toolbar.
Tap ALL PARAMS IF SELECTED
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PressENTER.

All parameters are stored in the cue.

18.3 Default store options in the Editor toolbar

The store optionsin the editor toolbar always revert to the default as defined in the System Settings
dia og box.

STORE OPTIONS is available on the Editor toolbar in select mode, parameter (levels) mode, and
cue mode.

19.0 Views

19.1 DMX ports

DMX port display now shows:. port number/DM X channel (1 - 512). Example: DMX universe 3,
channel 124 is displayed as 3/124.

19.2 Editor Toolbar
Buttons appearing in the default (idle mode) toolbar have been changed.

Note: These buttons are available when the editor isidle and you are using Enter syntax.

BUTTON FUNCTION

EDIT CUE Go to the selected cue on a playback device and enter the levelsto the
editor. Include only the fixtures and levels stored in the cue.

LOAD CUE Open the selected cue in the editor. Include only the fixtures and levels
stored in the cue.

LOAD STATE Open the selected cue in the editor. Include the fixtures and levels stored
in the cue and all fixtures and levels that are tracking.

LIBRARY Set Vector for library selection.
Note: This button is available when using Enter or Action syntax.

EDIT LIBRARY Open the selected library for editing.

19.3 Last selection

If the last fixture selection is still active, the fixtures are shown in yellow on the live spot and
channel displays.

Note: Thelast selection isaways active unless the editor has been completely reset by
pressing SHIFT + RESET.

19.4 LookAhead exam
You can examine the LookAhead mask.

D
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To examine the LookAhead mask

1 Open the Workspace.
2 Expand the Show node.
3 Tap LookAhead Mask.
A list of spotsin the LookAhead mask are displayed in the exam pane.

19.5 Topo

In the patch manager and in hard copy, the fixtures DMX addresses are displayed in a box under
each fixture.

19.6 Viewing a QList track sheet

QList track sheets show the cues, the fixtures used in the cues, and the parameter levelsin each
QList. You can view channels' dimmer levels or spots parameter levels. You select what is
displayed, by choosing the fixture type and parameter in the controls located in the view pane’s
header.

parameter selection

fixture selection )
‘ number of columns displayed

IDimmer '!IEHanneI ‘!. .

Figure 3: Track sheet controls in the pane header

IMPORTANT! To switch from viewing channels to viewing spot parameters, the view
pane's header must be visible.

To view a QList track sheet

1 PressEXAM.

2 SelectaQList.

3 PresseNTER.

4 Tap the side tab labelled TSheet.
A list of cues, the fixturesin each cue, and the cues where the selected fixtureis activeis
displayed.

5 Toview channels, choose channelsin the combo box list in the pane header. To view spots,

select spotsin the combo box list in the pane header. Select the parameter that you want to
view in the combo box list in the pane header.



